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• Mendeley 利用の前に

• 文献情報をまとめる

• 文献情報を集める/同期化

• 文献情報を利用する

• ユーザ同士でつながる

• Mendeley便利な機能

Mendeleyとは
利用形態、セットアップ

Mendeleyデスクトップ版

Mendeleyウェブ版

Wordへの参考文献挿入

プロファイル、
Peopole/Group

Mendeley Data
Mendeley Career
Mendeley Funding
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なぜMendeley？

たくさん論文や
データ見つけたけ
ど、管理が大変

同じ分野の研究者は
どんな文献を集めて
いるんだろう？？

正しく文献を共有する
のはどうすればいい？
もっとネットワークも

広げたい..!!

Mendeleyが解決
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研究ワークフローにおけるMendeleyの役割

研究企画・助成獲得

先行調査・分析

論文執筆・投稿

出版・発表

研究成果の浸透

業績評価

助成金情報収集

関連文献の収集
研究者のフォロー

文献情報の共有
効率的な論文の執筆

成果の積極的な発信
ネットワークの構築

インパクトの把握

東京大学様では機関版が
利用できます。
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Mendeleyの利用の前に
デスクトップ版、ウェブ版、モバイル版の連携

ウェブ版

デスクトップ版
Windows

デスクトップ版
Mac

デスクトップ版
Linux

モバイル版
iOS / Android

同期

ウェブデータベースとの連携

データのバックアップ

いつでも

どこでも

PDFの管理

参考文献リストの作成

Mendeleyを利用するにはユーザー登録が必要（ScienceDirect/Scopusのユーザー名と共通）
デスクトップ版とウェブ版を組み合わせ、同期をすることで場所や端末を選ばず同じ情報にアクセス可能
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Mendeleyの利用の前に
ユーザー登録

• Mendeleyの利用にはユーザー登録が必要（ScienceDirect/Scopusのユーザー名と共通）

ステップ1: http://www.Mendeley.com から

[Create a free account] 

ステップ2: 必要事項を画面に従い入力

ステップ3: アカウント登録し、[Continue to Mendeley>] ステップ4: 所属機関や職務区分、研究分野等プロファ
イル情報を入力して登録完了

登録後は
“Sign in”から

ログイン
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Mendeleyの利用の前に – セットアップ
デスクトップ版のインストール

• デスクトップ版のプログラムをダウンロードしてインストール

☑ Stay signed in をチェックして
おくとオフラインでも利用可能
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本日の講習会で講師が使用するプログラム：

• Mendeleyデスクトップ版
→ Windows版を使用

• Mendeleyウェブ版
→ ウェブブラウザとしてGoogle Chromeを使用

• Word plug-in
→ Microsoft office Word
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文献情報をまとめる（デスクトップ版）

文献PDFファイルから文献情報の取り込み

• 個々のPDFやフォルダをドラッグ＆ドロップするだけで書誌情報を自動抽出

• Watched Folder（監視フォルダ）を設定すると、フォルダにPDFを入れるだけで

書誌情報を自動抽出

個々のPDF PDFが入ったフォルダ

書誌情報を自動的に抽出

Watched Folder
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文献情報をまとめる（デスクトップ版）

書誌情報のマニュアル入力と関連ファイルの添付
• 書誌情報をマニュアルで入力してからファイルを添付

マニュアル入力

DOI、PMID、ArXiv IDで検索可能

PDFファイルを添付
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文献情報をまとめる（デスクトップ版）

PDFビューア

• PDFにハイライトや注釈を付けることができます

PDF内の検索

文献に対するノート
（ライブラリの検索対象）

PDF内の注釈
（ライブラリの検索対象外）

テキストを選択後、

ハイライト、注釈、コピー
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文献情報をまとめる（デスクトップ版）

DOIやPubMed ID等から
• 抽出された書誌情報が不完全な場合はマニュアルで編集可能

• DOI、PMID、ArXivで検索して情報補完

• 文献タイトルが正しければMendeleyオンラインカタログから情報補完可能

書誌情報の編集

DOI、PMID、ArXiv IDで検索可能

注意：Mendeley Web Catalogue
のインデックスから対象外にした
い場合は、チェックしてください
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動作確認 - 1

➢ PDFをデスクトップ版に取り込む

1. Mendeleyデスクトップ版を起動

2. 保存したいPDFをハイライト

3. PDFを中央欄にドラッグ＆ドロップ

4. PDFが入ったフォルダを確認

→ 右欄に書誌情報が自動的に取り込まれたことを確認
→ 日本語論文の書誌事項修正

3.   PDFビューアでPDFを開き、ハイライト・注釈付け。
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文献情報をまとめる（デスクトップ版）

ライブラリの管理

• 検索、並べ替え、フォルダを活用し、必要な文献を容易に探すことが可能

フォルダ
（新規作成、最近追加、
最近表示、お気に入り、
発表論文）

文献のフィルタ
（著者キーワード、著者名、タグ、出版物名）

お気に入り

未読

PDFあり

ウェブからPDFをダウンロード可能

並べ替え
（著者名、タイトル、出版年、出版物名、追加日）

タグの付与

ライブラリ内の検索
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文献情報をまとめる（デスクトップ版）

PDFのうっかり削除対策 – その1
保存したPDFを自動コピー

• Windows: [Tools] メニュー > [Options] -> [File Organizer] タブ
• Mac: [Mendeley Desktop] メニュー -> [Preferences…] -> [File Organizer] タブ

PDFの保存（コピー）場所

PDFをサブフォルダに分類

PDFを自動命名

※初期設定はすべてOFF

PDFのうっかり
削除対策

動作確認では
取り上げません。
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• PDFの保存フォルダを指定することによって自動的にMendeleyにインポートすることが
可能

Watched Folderの設定方法
[File] メニュー → [Watch Folder…]
または
Windows: [Tools] メニュー → [Options] → [Watched Folders] タブ
Mac: [Mendeley Desktop] メニュー → [Preferences…] → [Watched Folders] タブ

文献情報をまとめる（デスクトップ版）

PDFのうっかり削除対策 –その2 
Watched Folderの利用

・・
・・
・

動作確認では
取り上げません。

PDFのうっかり
削除対策
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文献情報をまとめる（デスクトップ版）

他の文献管理ツール等からのインポート
• 他のデータベースや文献管理ツールからBibTeX / XML / RIS形式のファイルをインポート可能

• 他の文献管理ツールからエクスポートする方法

- EndNote の場合

o [File] メニューから [Export...] を選択

o ファイル形式として XML (*.xml) を選択

- EndNote Basic (Web) の場合

o [フォーマット] タブから [エクスポート] を選択

o [レファレンス] ドロップダウンリストからエクスポートするレコードを選択

o [スタイル] ドロップダウンリストから [RefMan (RIS) Export] を選択

- RefWorks の場合

o [レコード] メニューから [エクスポート] を選択

o ファイル形式として (EndNote, Reference Manager, ProCite)] を選択

[File] メニュー >  [Import…]

PDFを移行する場合は、
先に書誌情報を移行した後に

PDFをインポート

動作確認では
取り上げません。
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文献情報をまとめる

ウェブ版との同期方法の指定（デスクトップ版）

Edit Settings

動作確認では
取り上げません。

添付ファイルの同期方法
ウェブ版と同期をとるフォルダの指定
※初期設定では全フォルダ
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Mendeleyウェブ版を使った文献の集め方

1. Web importerを使った文献の集め方
(Web importerをブラウザにインストール)

2. Mendeleyのダイレクトインポートを使った文献の集め方

3. Mendeleyカタログで文献を集める

4. Mendeley Suggestで文献を集める
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https://www.Mendeley.com/reference-management/web-importer/

Mendeleyウェブ版で文献を集める 1 : Web Importer

ウェブ版 Web Importerのインストール（ステップ1）
• Web Importerとは、各種データベース（ウェブサイト）から文献を取り込み可能にします

ウェブ版から

デスクトップ版から

Web Importerインストールページ
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Mendeleyウェブ版で文献を集める 1 : Web Importer

ウェブ版 Web Importerのインストール（ステップ2）

Chrome、FireFox:
ブラウザエクステンションをインストール

Safari、Internet Explorer:
ブックマークレットをツールバーにドラッグ＆ドロップ
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Mendeleyウェブ版で文献を集める 1  : Web Importer

Web Importerによるインポート
• ブラウザエクステンションまたはブックマークレットをクリック

（論文ページにのみ対応している場合あり）

PubMed（論文ページ） PubMed（検索結果ページ）

すべてまたは選択し
た文献を保存

開いたPDFから実行す
ることもできます

PLoS One（論文ページ）
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Mendeleyウェブ版で文献を集める 1  : Web Importer
動作例 GoogleScholar検索結果からMendeleyへのインポート
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Mendeleyウェブ版で文献を集める 2 : ダイレクトエクスポート

Mendeleyへのダイレクトエクスポート
製品内にMendeleyへのダイレクトエクスポートのメニューが用意されている場合があります

ScienceDirect(Advanced/Expert Search)

CiNii 医中誌Web

Scopus

現在、CiNii/医中誌Webからのダイレクトインポートは、適切に
機能しておりません。(本社対応中)

代わりの取り込み方法は、本スライド末尾に記載しております。
ご参照ください。
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Mendeleyウェブ版で文献を集める 3 : Mendeleyカタログ

Mendeleyカタログ上の文献情報の利用
• 世界中のユーザーが登録した文献をオンラインカタログとして検索し、自分のライブラ

リに文献情報を追加可能

読者数（Mendeley）
被引用数（Scopus）

ライブラリに
保存

ライブラリに保存

電子ジャーナ
ルにリンク

電子ジャーナ
ルにリンク

読者数（Mendeley）
被引用数（Scopus）
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Mendeleyウェブ版で文献を集める 4 : Mendeley Suggest

Mendeley Suggest機能
• Fileをuploadするとユーザー別にカスタマイズしたおすすめ論文とユーザーを表示

ライブラリに保存 電子ジャーナルにリンク

・ 自分のライブラリ内の論文に基づいたおすすめ
・ 自分のプロファイルや分野に基づいたおすすめ
・ 最後に追加・閲覧した論文に基づいたおすすめ

類似のおすすめ文献を表示

研究者をフォロー
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文献情報を集める（ウェブ版）

ライブラリの表示

• Library より文献の追加、文献情報の編集、PDFの添付などが可能

PDFファイルを添付

並べ替え

検索

文献の追加

PDFファイルのドラッグ＆
ドロップによる文献の追加
も可能

個々のPDF

動作確認では
取り上げません。
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東京大学様Mendeley機関版ユーザー登録

https://www.dl.itc.u-tokyo.ac.jp/gacos/faq/men.htmlをご参照ください。

https://www.dl.itc.u-tokyo.ac.jp/gacos/faq/men.html
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• https://www.Mendeley.com/account/details/ から確認可能

自分のアカウントが利用できる
ディスクの使用状況
無料版：２GB
機関版：100GB

文献情報を集める（ウェブ版）

空きディスク容量の確認

自分がオーナーとなるプライ
ベートグループ全体で利用でき
るディスクの使用状況
無料版：100MB
機関版：100GB

動作確認では
取り上げません。
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重要
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重要 ! 集めた文献をデスクトップ版・ウェブ版で同期化

• 同期により、どこからでも同じ環境を利用可能に

• デスクトップ版の起動時に自動的に同期、または [Sync] ボタンで同期

ウェブ版

デスクトップ版
Windows

デスクトップ版
Mac

デスクトップ版
Linux

モバイル版
iOS / 

Android

同期

デスクトップ版の
終了時には自動的に同

期しません
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文献情報を利用する

Mendeley Word Pluginのインストール

Windows:

Mac:

デスクトップ版 Tools から Install MS Word Pluginをクリック

LibreOfficeにも対応



Mendeley |    37

文献を挿入したい個所で
[Insert Citation] をクリック

文献情報を利用する

Mendeley Word Plugin 参考文献情報の挿入

文献符号が挿入される

ダイアログボックスで検索して
[OK]

Mendeley本体で検索して [Cite]
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文献情報を利用する

Mendeley Word Plugin 連続した引用符号の挿入
• ダイアログボックスで連続して挿入

• 複数の引用符号を選択してから [Merge Citations]
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文献情報を利用する

Mendeley Word Plugin 参考文献リストの作成

参考文献リストを作成したい個所で
[Insert Bibliography] をクリック
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文献情報を利用する

Mendeley Word Plugin 引用スタイルの変更・カスタマイズ

スタイルを変更

新規スタイルをインストールインストール済のスタイルを選択

日本語の引用スタイルSIST02も含む
7,000以上のスタイルが利用可能
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文献情報を利用する

Mendeley Word Plugin
Mendeleyとのリンクを解除したファイルの作成

WordファイルはMendeleyとリンクされた状態になっています。
この状態で参考文献リストを編集しても、[Refresh] をクリック
すると元の状態に戻ってしまいます。

Mendeleyとのリンクを解除した
ファイルを別ファイルに出力

動作確認では
取り上げません。
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ソーシャル機能を使う

個人プロファイルの編集、発表論文の公開

• 個人のホームページとして発表論文を公開することができます

E-mail、Password、
肩書、分野を変更

各種情報を編集 プロファイル情報
の公開範囲を設定

名前をクリックしてプロファイル
の編集ページを表示

発表論文を追加
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ソーシャル機能を使う
出版論文の公開

• 自著の論文をMendeleyユーザーに公開

ドロップしてライブラリに保存

フォルダを指定してライブラリへアップロード

ドロップしてライブラリに保存

My Publications

動作確認では
取り上げません。
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• 自著の論文がどのように利用されているかをモニタリング

ソーシャル機能を使う

Mendeley Stats

以下の情報を利用

Scopus著者プロファイルとリンク付け

エルゼビアに出版された論文が何回アクセスされているか

Scopus収載論文がどのように引用されているか

Mendeleyを介してどのように共有されているか、読者層（分野、肩書、国）

メディアにどのように取り上げられているか

動作確認では
取り上げません。

・ORCID/Scopus Author IDとの関連付け
・興味分野
・自己紹介文
・共著者
・フォロー、フォロワー

h-indexと被引用数（Scopus)
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ソーシャル機能を使う

他の研究者(Mendeleyユーザ)の検索

• Mendeleyに登録している他の研究者をフォローし、その活動を見ることができます

フォローする

発表論文フォローしている研究者や参加して
いるグループの活動が表示されます
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グループの種類 投稿できるのは？ 閲覧できるのは？ 共有できる文献 適した用途

Private Ownerに招待されたメンバー
無料版は25名まで
※ アップグレード可能

Ownerに招待された
メンバー

書誌情報＋
フルテキスト (PDF)

プライベートな
研究プロジェクト

Invite-only Ownerに招待されたメンバー
無料版は25名まで
※ アップグレード可能

誰でも 書誌情報 リーディングリストの
公開

Public 誰でも 誰でも 書誌情報 オープンなディス
カッショングループ

デスクトップ版でもウェブ版でも
作成できます

ソーシャル機能を使う

グループの種類と作成
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ソーシャル機能を使う
プライベートグループの利用 他のメンバーの招待と管理

• グループを作成したOwnerが他のメンバーを招待する

招待する側
（Owner）

招待された側

招待された人は、[Accept] して
グループに参加

Owner権限を譲渡、
グループから削除
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ソーシャル機能を使う

Public Group 利用例

Publicグループの例

同じ興味を持つユーザーと情報
交換することができます
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Invite-onlyグループの例

研究室の研究成果、リーディン
グリストの公開に適しています。

ソーシャル機能を使う

Invite Only Group利用例
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ソーシャル機能を使う

プライベートグループメンバーによる共有
• 書誌情報とPDFを共有することができます（注釈も共有）

• 無料版では25人までのグループを5つ作成可能、1人あたりのディスク容量は100MB

共有したい文献をグルー
プにコピー → 同期

*機関版では100人までのグループを無制限に作成可能
1人あたりのディスク容量は100GB

ウェブ版でも
同様の操作が

可能
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東京大学様Mendeley機関版ユーザー登録

https://www.dl.itc.u-tokyo.ac.jp/gacos/faq/men.htmlをご参照ください。

https://www.dl.itc.u-tokyo.ac.jp/gacos/faq/men.html
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ソーシャル機能を使う

Search People/ Groups

”Join” でメンバー登録申請
キーワードサーチ

人名でサーチ

Groupタブ

Peopleタブ

”Follow” でこの研究者の研究をフォロー

グループを検索して参加
人を検索してフォロー
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• Mendeley 利用の前に

• 文献情報をまとめる

• 文献情報を集める/同期化

• 文献情報を利用する

• ユーザ同士でつながる

• Mendeley便利な機能

Mendeleyとは
利用形態、セットアップ

Mendeleyデスクトップ版

Mendeleyウェブ版

Wordへの参考文献挿入

プロファイル、
Peopole/Group

Mendeley Data
Mendeley Career
Mendeley Funding
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Mendeley Data
研究データの管理

• 研究データを保存、プロジェクトでの共有、そして公開することが可
能

• あらゆる研究データの閲覧、引用が可能

• データセットはDOIが付与されるので、引用が可能

要サインイン
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Mendeley Data
研究データのアップロード（10GB/File）

タイトル

貢献者リスト

ファイルの選択

所属機関

データのカテゴリ

ライセンス種別の選択
CC BY 4.0が初期設定
CC BY NC 3.0、MIT、GPL
などを選択可能（解説も表示
されます）

データの概要

再現方法

関連するURL（リンク）

公開オプションの選択
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Mendeley Data
研究データの検索

キーワード検索

ファイルタイプ
タイトルや貢献者リスト

被引用論文へのリンク

ファイルタイプによる
絞り込み
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Mendeley Data
研究データの情報

タイトル
貢献者リスト（Mendeleyプロファイル）

データセット

被引用論文

バージョン情報

引用情報

カテゴリーと
ライセンス情報等は
ページ下部に記載
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• Mendeley 利用の前に

• 文献情報をまとめる

• 文献情報を集める/同期化

• 文献情報を利用する

• ユーザ同士でつながる

• Mendeley便利な機能

Mendeleyとは
利用形態、セットアップ

Mendeleyデスクトップ版

Mendeleyウェブ版

Wordへの参考文献挿入

プロファイル、
Peopole/Group

Mendeley Data

Mendeley Career
Mendeley Funding
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Mendeley Career
研究関連のキャリア情報

ジョブ検索・ジョブアラート設定・ジョブ管理・アカデ
ミア関連のジョブ・全てのジョブ・読み物

ジョブの検索が、キーワードや分野、
ロケーションなどで可能

ジョブ情報の掲載も
可能（ベータ版）
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Mendeley Career
ジョブ情報の検索

分野やロケーションなどで
ジョブの検索が可能

アラートの設定

詳細画面へ お気に入りに登録
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Mendeley Career
ジョブの詳細画面

前後のジョブへ
移行

応募ボタン
クリックすると1
次情報のページに
遷移

ジョブの概要
ジョブの紹介文
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• Mendeley 利用の前に

• 文献情報をまとめる

• 文献情報を集める/同期化

• 文献情報を利用する

• ユーザ同士でつながる

• Mendeley便利な機能

Mendeleyとは
利用形態、セットアップ

Mendeleyデスクトップ版

Mendeleyウェブ版

Wordへの参考文献挿入

プロファイル、
Peopole/Group

Mendeley Data
Mendeley Career

Mendeley Funding
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Mendeley Funding
助成金情報ポータル

キーワード検索

分野別、タイプ別（奨学金、研究資金、賞、プロジェクト等）

お気に入りリスト



Mendeley |    65

Mendeley Funding
助成金情報の検索

キーワード検索

フィルター
・分野
・助成金タイプ
・国籍
・金額
・締切日
・申込者属性
・提供団体

並び替え
・更新日付
・締切日
・金額
・関連性
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Mendeley Funding
助成金情報ページ

・タイトル
・提供団体
・金額
・締切日
・申込者属性

・分野
・概要
・応募資格
・担当者
・締切情報

締切日までの日数

・1次情報へのリンク
・お気に入りに追加
・助成金情報をメール
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Mendeley Funding
助成金提供団体

団体種別による
フィルター
・政府系
・企業系
・財団
・NPO
・国際機関
・協会
・学術機関

国でフィルター

団体一覧と情報件数
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• 使い方ガイドページ

https://www.elsevier.com/ja-jp/solutions/mendeley/mendeley-guide
クイックレファレンスガイド、バージョンアップ情報など

• Help 画面、Guides Mendeleyページ

• ヘルプデスク、カスタマーサービス

• https://service.elsevier.com/app/home/supporthub/mendeley/

お問い合わせ先

Mendeley デスクトップ版

https://www.elsevier.com/ja-jp/solutions/mendeley/mendeley-guide
https://service.elsevier.com/app/home/supporthub/mendeley/
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(付録)
: CiNii検索結果からMendeleyへの取り込み
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検索した文献:政権交代が行政施策・組織に及ぼす影響に関する一考察 : 英国の地域政策をめぐる変化を事例に

出展 :国士舘大学政経論叢 国士舘大学政経論叢 2011(4), 1-35, 2011-12国士舘大学政経学会

/

付録 - CiNii検索結果からMendeleyへの取り込み

RISで表示を選択

1. CiNii検索結果をRISで表示

動作確認では
取り上げません。
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右クリックで[名前を付けて保存] -> ファイル名 : 適宜設定 -> 

ファイル種類 – すべてのファイル

2. RIS形式で保存
付録 - CiNii検索結果からMendeleyへの取り込み 動作確認では

取り上げません。



Mendeley |    72

3. MendeleyデスクトップでImport -> 取り込み

Mendeleyデスクトップ版の[File] -> [Import] -> RISを選択。

RISで保存したファイルを指定。

付録 - CiNii検索結果からMendeleyへの取り込み 動作確認では
取り上げません。


